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THE POWER OF LAYER
MASKING

Some men have commitment problems—or so the
cliché goes. Well, I’ve met quite a few Photoshop

users with deep-rooted commitment problems, and yes,
I count myself among them. We fear the commitment
of making an irrevocable image-editing decision that
we’ll regret in the morning. In fact, if it wasn’t for one
essential feature in Photoshop—layer masks—I would
be a nail-biting, sleep-deprived wreck.

Layer masks allow the commitment-wary and -weary
the opportunity to try various approaches to their
images without losing the flexibility to change their
minds. In this chapter, you’ll be introduced to the per-
fect partnership—layers and layer masks—and how
they work hand in hand (or should I say pixel in
pixel?). This chapter addresses

• How to work with painted, gradated, and selec-
tive layer masks

• When to use pixel or vector layer masks

• Why layer masks are powerful, flexible, and
creative

• How to combine multiple image exposures

If I had to decide between giving up coffee or layer
masks, I wouldn’t think twice. I hear that tea has caf-
feine, too. So brew a cup of your favorite beverage and
let’s explore one of the most exciting and essential fea-
tures of Photoshop. 



WORKING WITH LAYER MASKS
Layer masks are the soul of Photoshop—the key to
combining images in a completely nondestructive
manner. They enable you to move, hide, blend,
conceal, and experiment with image combinations
to your heart’s content—all without ever losing a
single pixel. 

Each layer can support a pixel and a vector layer
mask. Pixel-based masks are used for blending pho-
tographs together, to gradually have images or tone
and color changes fade in and out, and wherever
painted or soft edge quality is desired. Vector-based
masks are employed when Bézier accuracy and
crispness is required. Both types are very useful, but
the pixel-based mask is the true workhorse of the
compositing artist.

Background and type layers do not support layer
masks. Adjustment Layers automatically come with
a layer mask. To add a layer mask to an image layer,
either click on the Mask button in the Layers
palette to add a white layer mask, or (Option-click)
[Alt-click] to add a black layer mask. You can also
choose Layer > Add Layer Mask > Reveal All to
add a white layer mask, or Layer > Add Layer Mask
> Hide All to add a black layer mask. 

Just like Channel masks, pixel layer masks can be
black or white with all shades of gray in between.
Wherever the mask is darker, less image effect will
show through; wherever it is lighter, more image
effect shows through. In a nutshell, black conceals
and white reveals—meaning that if you want part
of an image to show through, then the correspon-
ding mask must be light. If you don’t want an image
area to be visible, the mask must be black. 

T i p

Use the masking mnemonic, “White Reveals and
Black Conceals” when working with layer masks.

Painted Layer Masks
When layers were introduced with Photoshop 3.0,
I was having a problem adopting the new layered,
dimensional approach to combining images. To
understand how layers and layer masks worked, one
night I opened two images that I liked (figure 7.1),
literally plopped one on top of the other by drag-
ging the Pegasus image over to the tree image,
added a layer mask to the top one, and then started
painting. If you, too, have struggled to grasp the
concept of combining images using layer masks, fol-
lowing the same steps I did may help: 

ch7_wintertrees.jpg 

ch7_pegasus.jpg 
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figure 7.1
The two source images.

1. Open both images and decide which one will
serve as the image background. I chose the
winter tree branches image as the background,
and the Pegasus image as the foreground
subject.

2. Use the Move tool to drag the Pegasus over to
the winter tree branches image and name the
layer Pegasus.



3. Click on the Layer Mask button. Notice that
nothing has changed in your image and that
Photoshop has added a white layer mask to
the Pegasus layer (figure 7.2). 

4. Paint with a soft, black brush over those areas
of the Pegasus layer that you do not want to
see (figure 7.3). If by accident you paint over
an area that you do want to see, press x to
switch the foreground and background colors,
and paint over the area you want to see with
white. Keep in mind, white reveals and black
conceals—meaning that if you paint with
black on the layer mask, you will be hiding
“Pegasus” pixels.

figure 7.3
Painting with a large, soft black brush quickly conceals areas
of the Pegasus image you do not want to see.
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figure 7.2
Adding a white layer mask does not alter the image in 
any way.

5. In a few minutes, you should have the image
roughly combined. To fine-tune the image
edges, zoom in on an area (figure 7.4) and
paint with a smaller, harder brush. Press x to
paint with black or conceal, or white to reveal
the Pegasus layer. (Option-click) [Alt-click]
on the layer mask to view it (figure 7.5).

figure 7.4
Zoom in and paint with a smaller, harder brush to fine-tune
how the image elements come together. 

figure 7.5
Viewing the layer mask shows that white reveals and black
conceals.



6. When you’ve finished, select File > Save As
and save the file in the PSD or TIFF format
(these are the two recommended formats that
will maintain the layers). When you return to
this image, you can readjust it any way you
want by painting on the layer mask again. 

Now you know how I learned layer masking—I
spent an evening with these two images and kept
painting back and forth to create the image shown
in figure 7.6. It took me a few hours, but I finally
got it and haven’t looked back since. 

White and Black Layer Masks
When you click on the Layer Mask button in the
Layers palette, Photoshop adds a white layer mask,
which reveals the entire image. Starting with a
white layer mask is a subtractive mode of working.
You see the entire image and paint away with black
or gray the areas you do not want to see. 

(Option-clicking) [Alt-clicking] the Layer Mask
button adds a black layer mask, which hides the
entire layer. You need to paint with white to add
the image back—to work additively you bring the
image back into view. 

This technique is used very often in portrait
retouching. Photographers will sharpen the entire
portrait, and then by adding a black layer mask to
the sharpened layer, they paint back in the sharp-
ness only where it is needed—in most cases the eyes
and lips (figure 7.7).
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figure 7.6
The final image playfully reveals winter trees interspersed with a Las Vegas shopping arcade.



Gradated Layer Masks
The largest paintbrush in Photoshop is the
Gradient tool. You can use it on layer masks to con-
trol tonal and color effects and to seamlessly blend
images together. 

Darkening Image Edges
Adjustment Layers in combination with blending
modes and layer masks offer a straightforward
method for lightening and darkening (traditionally
called dodging and burning) areas in an image where
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figure 7.7
The layer mask controls where the sharpening effect is applied to the original image.

you want to draw attention. Light areas attract the
viewer’s focus, whereas dark areas are of less visual
interest. 

Traditionally, photographers often burned or dark-
ened the edges of their prints to focus the viewer’s
attention on the center. If you employ this tech-
nique, you should do it as subtly as possible so that
it’s not noticeable. After finishing a composite, I
often add a slight edge burn to darken the outer
edges and keep the viewer’s eyes focused on the cen-
ter, as figure 7.8 illustrates.

ch7_pear.jpg 



figure 7.8
Framing the pear with a hint of darkness maintains the focus
on the center of the image.

You can quickly create this darkening effect using
an Adjustment Layer and the Gradient tool:

1. Activate the topmost layer of your composite
or image.

2. Add a Levels or Curves Adjustment Layer—
it doesn’t matter which one you choose. As
soon as the interface pops up, click OK with-
out changing anything. 

3. Change the blending mode to Multiply and
reduce the opacity to 50%. The entire image
will become darker (figure 7.9). 
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figure 7.9
Changing the layer blending mode to Multiply darkens the
entire image.

4. Select Image > Adjustments > Invert or 
(Cmd + I) [Ctrl + I] to invert the layer mask,
which will turn it black.

5. Activate the Gradient tool and select the 
second gradient from the Gradient picker—
Foreground to Transparent (figure 7.10).
Verify that white is the foreground color; if 
it isn’t, press x to switch the foreground and
background colors.



figure 7.12
After one gradient pull from each corner, the image is more
focused.
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figure 7.11
Working in full-screen mode and starting well outside the
image lets you subtly darken the image edges.

figure 7.13
Continue adding gradients to create an image to your liking. 

8. If you are not at all happy with the effect,
throw away the entire Adjustment Layer and
start over. 

Once you’ve darkened image edges like this a few
times you’ll be able to do it very quickly, giving your
images a professional and subtle polish.

figure 7.10
You need the Foreground to Transparent gradient for this
technique to work.

6. Press f to place the image into full-screen
mode and zoom out to see the entire image. 
I prefer to start the gradient well outside the
image (figure 7.11). Pull the first gradient
from the upper left toward the center of the
image, and then repeat on all four corners
(figure 7.12). Continue as necessary to create
an image to your liking, as I did in figure 7.13.

7. Turn the Image Adjustment Layer view
column on and off to view the image with and
without the darkening effect. If you like what
you see, save the file. If you are not satisfied—
maybe it’s too light or too dark—adjust the
layer opacity to create the desired effect. 



Balancing Image Exposure
Using the Gradient tool on a Levels or Curves
Adjustment Layer is a quick and easy method for
balancing exposure, as John Warner did with the
panoramic image shown in figure 7.14. 

To balance the image exposure, John used a Curves
Adjustment Layer with a gradated mask as follows:

1. After scanning in the image, John added a
Curves Adjustment Layer and lightened the
entire image (figure 7.15). 

2. By using a black-to-white gradient from right
to left, he concealed the tonal change on the
correct side of the image and let the change
show through on the left, which lightened the
left side and balanced the exposure perfectly
(figure 7.16). 
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figure 7.14
The left side of the original image is just a little too dark.

figure 7.15
Lighting the entire image using a Curves Adjustment Layer.

figure 7.16
The Gradient tool concealed the change on the right side of the image and revealed it on the left side.



Seamlessly Blending Images
Building image backgrounds by combining two or
more images is a fantastic method for building up a
stock of creative backdrops. The Gradient tool can
help you achieve good results very quickly. 

ch7_sunset.jpg 

ch7_reflection.jpg 

1. Open the two images you want to blend and
determine which one will serve as the back-
ground and which one will be in the fore-
ground. Drag the top image over to the
bottom image with the Move tool. When
dragging images—especially Background
layers—it helps to do it with confidence or 
as I like to say, with schwung. Otherwise,
Photoshop will pop up the polite yet irritating
message: “Could not complete your request
because the layer is locked.” So drag quickly
and with confidence. Pressing and holding the
Shift key will place the top image exactly on
the center point of the bottom image.

2. Add a layer mask to the top image and reduce
the layer opacity to 50%. This helps you find
the best position for the image, since you 
can see through to the lower image (see 
figure 7.17).

3. Click on the layer mask to make sure it is
active, activate the Gradient tool, and choose
the third gradient from the gradient library—
black to white. Start the gradient where you
want the bottom image to show through com-
pletely and draw up. Release the mouse when
you reach the point in the top image that you
want to see completely (figure 7.18).

4. Increase the layer opacity to 100% to see the
results (figure 7.19).
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figure 7.17
After dragging one image onto another, reduce the layer
opacity so that you can view the relationship between the two.

figure 7.18
Using a black-to-white gradient to reveal the buildings in the
lower part of the image.

figure 7.19
Set layer opacity to 100% to see the image combination. 



Adjusting Position
The layer and the layer mask can be moved
together or independently of one another. To move
the layer and mask together, make sure they are
linked; to move either one independently, unlink
them by clicking on the small chain between the
layer and the Layer Mask icon.

To change the position of the sky:

• Move the sky with the layer mask (figure
7.20) by grabbing the top layer in the image
and moving it using the Move tool.

figure 7.20
Moving the layer and the layer mask together.

• Move just the sky by unlinking the sky pixels
from the layer mask. Click on the small chain
between the layer and Mask icon (figure
7.21) and then make sure the layer is active
before moving it.

• Move just the mask by unlinking the sky
pixels from the layer mask. Click on the small
chain between the layer and Mask icon, and
then move the layer mask (figure 7.22).
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figure 7.21
Unlinking the layer and layer mask by clicking the link icon
lets you move just the layer or the mask.

figure 7.22
Moving the layer mask is very useful for fine-tuning the tran-
sition position.

There are many times when you want the mask to
stay linked with the layer, but very often it is quite
useful to move the layer mask—for example, when
the steepness of the blend is perfect, but you want
to change its position slightly.



Experimentation
The best thing about the Gradient tool and layer
masks is that you can redo the blend over and over
again to get the image exactly right. Take a moment
to experiment with the Gradient tool—create very
steep transitions by only drawing for a short dis-
tance; create a very long transition by drawing the
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figure 7.23
Experiment with the Gradient tool to create a variety of image effects.

Long gradient

Steep gradient

Right to Left gradient

Diagonal gradient

gradient across the entire image. Try it going from
right to left, or diagonally.  I’ve provided a few vari-
ations in figure 7.23. Every time you draw a new
gradient, the previous blend is overwritten, letting
you experiment to your heart’s content.  



Refining Blended Images
Many times an image combination requires more
than a straight-line gradient to blend in a new
background or sky, as shown in figures 7.24 and
7.25, in which I replaced the sky with a more dra-
matic one.

ch7_stormsky.jpg 

ch7_pony.jpg

Combine the Gradient and Brush tools to refine
layer masks to improve images as described here. 

1. Open both images and drag the sky image on
top of the pony image. 

2. Add a layer mask to the sky image and draw 
a gradient from below the horizon to the top
of the new sky to create the results shown in 
figure 7.26.

Now the problem is that the new sky is cover-
ing the pony, which of course needs to be in
front of the sky. 
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BEFORE

AFTER

figure 7.24

figure 7.25

figure 7.26
The initial gradient on the layer mask adds the sky but covers
the pony.

3. Click on the sky layer mask, and using a black
brush with 50% hardness, carefully paint
inside the pony to block the sky from being
visible, as shown in figure 7.27. 

4. (Option-click) [Alt-click] the layer mask to
see exactly what is going on—the gradient is
letting the new sky blend in, and the black
areas are blocking the sky from affecting the
pony (figure 7.28). 

5. If by chance you paint into the sky and see a
telltale halo (figure 7.29), (Option-click)
[Alt-click] the gradient directly adjacent to
the mistake. This samples the gray with the
density of the gradient, and as you paint the
sky will blend in without showing any density
differences. 

BEFORE



figure 7.27
Painting on the layer mask protects the pony from being
affected by the sky layer.

6. If necessary, (Option-click) [Alt-click] to 
sample darker or lighter density areas from the
gradient as you work up or down the pony’s
head. You can see the detail work I did in 
figure 7.30.
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figure 7.28
Viewing the layer mask is often a good way to catch errors.

figure 7.29
The lighter halo around the pony’s head is a telltale sign of
poor masking.

figure 7.30
Sampling the density of the gradient lets you paint on the
layer mask to remove halos.

Selective Changes
When you make a selection and then add an
Adjustment Layer, Photoshop automatically trans-
fers the active selection to the layer mask and the
adjustments only take place within the active areas.
Starting with a selection is demonstrated here to cor-
rect the backlit photograph of the golf course sign:

ch7_golfsign.jpg 

1. Select the sign with the Polygon Lasso tool
and feather the selection by 1 pixel to soften
the edges ever so slightly (figure 7.31).

2. Add a Curves Adjustment Layer and raise the
midtones (figure 7.32). As you can see,
Photoshop has transferred the Lasso selection
into the layer mask. The selected area—the
sign—is white, so the Curves correction only
takes place through the white areas of the
mask, lightening the dark sign.



figure 7.31
Select the area you need to change.

MERGING PHOTOGRAPHIC
EXPOSURES
Photographers are always looking for better tools
and techniques to express their vision and not let
the limitations of their tools negatively impact the
quality of the final image. Some of the limitations
they face include:

• The dynamic range of the scene is wider than
what the digital camera or film can capture.

• The lens isn’t wide enough to frame the full
grandeur of the scene.

• The natural light doesn’t illuminate the scene
properly.

• The scene contains mixed color temperatures
that conflict with one another. 

Today photographers still face these challenges, but
their tools have improved—they use professional
digital cameras and can preview their images on
laptops while on location or on set. The huge
advantage of working with a professional digital
camera is that a photographer can combine a series
of exposures or acquire the file with multiple set-
tings in Photoshop to achieve the following:

• Extend the dynamic range

• Expand the view of the scene

• Capture light over time

• Color balance a scene without having to gel
or filter the lights or lens

Note that you can achieve similar results when
working with film capture. However, the advantage
of working with a high-quality digital RAW file—
which is the native, unprocessed data as it was cap-
tured by the camera sensor—and the precision with
which you can register the multiple files does give
digital capture the definitive upper hand. 

Adobe Camera RAW
Many prosumer and professional digital cameras
produce RAW files, which offer a number of advan-
tages, including hi-bit depth, lack of compression
artifacts, and flexibility in image processing. Check
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figure 7.32
Adding an Adjustment Layer with an active selection lets
you work on the active area without affecting the rest of the
image.

3. To soften the transition between the lighter
sign and the background, choose Filter > Blur
> Gaussian Blur and use a low setting of 1. 

All active selections will automatically be trans-
ferred into the layer mask when you add an
Adjustment Layer, allowing you to fine-tune
images with great precision and care. You’ll find
lots more information on applying tonal and color
corrections in one of my other books, Photoshop
Restoration and Retouching.



your camera’s documentation to determine if it will
shoot RAW files. 

I use the Adobe Camera RAW feature in Photoshop
CS to process RAW files from my Nikon and Fuji
cameras. In the example in the following section,
we’ll process the same RAW file twice to create a
well-exposed image. 

Luminance Masking
Very often a scene will have too much contrast.  No
matter how you adjust the camera exposure or
tweak the file in software, either the highlights are
too bright or the shadows are blocked. To create a
file with detail in both the highlights and shadows,
start by acquiring the same RAW file twice—once
for the highlights and once for the shadows—so
that you can capture the best of both images and
create an image that has good shadow information
and bright highlights with detail.

ch7_helmet.nef

1. Working with RAW files in Photoshop CS
opens the Adobe Camera RAW interface. 
Use the sliders to process the image so that 
it captures good highlight information. The
shadows will look washed out, but that is fine.
Make sure to keep the file in 16-bit (figure
7.33) and save it to your hard drive using 
the name your subject_light.psd.

2. Open the original image in Adobe Camera
RAW again, but this time process it so that it
captures good shadow information (figure
7.34). Now the highlights will be completely
blown out and without detail—that is OK.
Save the file to your hard drive using the
name your subject_dark.psd.

3. Drag the light file on top of the dark file. Press
the Shift key while dragging so that the file
lands in perfect registration. Rename the
layers to make it easier to keep track of which
is which.
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figure 7.33
Acquiring the file for the highlight values.



4. Turn off the highlight layer, click on the 
dark layer to activate it, and load the image
luminosity by pressing (Cmd + Option + ~)
[Ctrl + Alt + ~]. If your keyboard doesn’t
have a tilde key (~), (Cmd-click) [Ctrl-click]
on the RGB icon in the Channels palette. 

Loading the luminosity activates the bright-
ness values in each channel that are above
128, and the resulting selection is shown in
figure 7.35. 

5. Turn on and activate the highlight layer. Click
on the Layer Mask button, which transfers the
luminosity mask to the layer mask and seam-
lessly combines the images (figure 7.36). 

6. To refine the layer mask, use Curves to darken
the mask (figure 7.37). Keep an eye on the
image highlights via the Info palette; you
don’t want them to go above 245. Make sure
the helmet maintains subtle tonal detail in
the highlights.

figure 7.35
Turn off the top layer and activate the Background layer
before loading the image luminosity.
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figure 7.34
Acquiring the file for the shadow values.



figure 7.36
Turn on the top layer and activate it. Clicking on the Layer
Mask button transfers the active selection to the layer mask.

7. Adjust the layer opacity for the desired effect.
I often experiment at the same time with the
layer blending modes to see if the effect is
pleasing. To create the final image, I reduced
the top layer opacity to 80%.

T i p

After acquiring a RAW file, duplicate it and close
the original without saving changes. This lets you
reopen the same RAW file without having to save
the first one to your hard drive.

Once the images are combined and you’ve saved the
new combination version, you can delete the saved
files. All in all, this is a good technique to quickly
help you bring image contrast within a printable
range—special thanks to Stephen Johnson and Jeff
Schewe for showing me this technique.

Emphasizing the Essential
Similar to the luminance-masking technique I just
discussed, you can also extend an image’s dynamic
range to increase image drama by deciding which
areas you want to reveal or conceal in creating the
final image.

ch7_cloudtower.nef 

1. Follow Steps 1 and 2 of the previous task to
acquire the same image file twice—once for
the highlights, in this example the clouds 
(figure 7.38), and once for the shadow infor-
mation of the castle ramparts (figure 7.39).
Remember to save the first file after you
acquire it to your hard drive so that you can
open the original RAW file again with differ-
ent Camera RAW settings.

2. Drag the images into one file, add a layer
mask, and use the Gradient tool to initially
combine the images (figure 7.40). 

3. Use a large soft, black brush to paint over the
towers to complete the photograph, as shown
in figure 7.41. 

This technique is useful for accentuating specific
image areas with the ability to paint information
back and forth via the layer mask. 
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figure 7.37
Adjusting the layer mask using Curves lets you fine-tune the
image combination.
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figure 7.38
Acquiring the file for the highlight values.

figure 7.39
Acquiring the file for the shadow information of the tower stone.



figure 7.40
Use the Gradient tool on the layer mask to create the initial
image combination.

Increasing Dynamic Range
John Warner is the consummate professional 
photographer—skilled, talented, creative, consci-
entious, and always ready to try new tools and tech-
niques to produce better images. Having worked for
over 20 years with film technology, John is now an
avowed digital photographer who takes great pleas-
ure in planning, composing, and compositing
images. One of John’s specialties is interior and
exterior architectural photography—a field that
brings many constraints and challenges with it. For
example, it’s pretty hard to move a building to face
the light, or to close the window to control the
exposure, when the client wants to simultaneously
see the beautiful view and the interior of the room. 

John photographs with high-end, digital cameras.
After framing the image, he locks down the camera
on the tripod and takes separate exposures for shad-
ows, midtones, and highlights to create images that
hold information from the darkest shadows to the
brightest highlights. 

C a u t i o n

When photographing multiple exposures, it is
very important to set the camera to either manual
exposure or Aperture Priority, both of which let
the photographer set the f-stop (the aperture) and
adjust exposure by changing the shutter speed.
The slightest variation in f-stop will change the
depth of field and the size of the subject in the
image ever so slightly, making it more difficult to
seamlessly combine the images.

Combining Exposures Using Layers 
and Masks
After photographing two exposures for the bedroom
scene—one for the room (figure 7.42) and one for
the exterior setting sun (figure 7.43)—John
acquired and saved each file with the respective
names outside and inside, and then blended them in
Photoshop as follows:
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figure 7.41
Painting over the towers in the layer mask with a soft black
brush allows the shadow information to show through.



figure 7.42
John always exposes for the brightest values first, which in
turn determine the ensuing exposures.

figure 7.44
The blue channel has the clearest window definition.
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figure 7.43
The exposure for the window light.

1. After bringing the two exposures into one
file, John needs to mask the windows to com-
bine the two exposures. He inspected the
three channels of the inside layer and saw
that the blue channel had the clearest win-
dow information (figure 7.44).

2. He duplicated the blue channel and increased
its contrast with Curves (figure 7.45). He
then selected all the nonessential image
area—everything that is not window—and
filled it with black (figure 7.46). 

3. Returning to the Layers palette, John activated
the window alpha channel using (Cmd +
Option + 4) [Ctrl + Alt + 4]. He made sure the
inside layer was active and clicked the Layer
Mask button, which transferred the active
selection to the layer mask (figure 7.47).

Red

Green

Blue



figure 7.45
Increasing the contrast using Curves makes the alpha mask
denser and better defined.

figure 7.47
After transferring the alpha mask to the layer mask.

4. John inverted the layer mask to reveal the
room interior (figure 7.48).

5. Upon careful inspection, John refined the
layer mask using a slight Gaussian Blur and a
bit of painting to repair any unsightly seams to
create the final image shown in figure 7.49.
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figure 7.46
Areas that don’t contain window information are filled 
with black.

figure 7.48
Inverting the layer mask reveals the window exposure.



All in all, this technique works best with static sub-
jects such as buildings and still lives. In the example
shown in figure 7.50, the final image required three
separate exposures: the room interior, the outside
scene, and the fireplace. John then combined the
three exposures and added a few additional flames to
the fire to make the room even more inviting.

Combining Color Temperature
Photographing an interior scene with natural day-
light coming in through the windows has always
been a challenge for architectural photographers.
This is because in most cases the room is lit with
tungsten light, which has a color temperature of
3,400 degrees Kelvin and is inherently orange. 
The daylight coming through the windows is
approximately 5,500 degrees Kelvin and is much
bluer than the tungsten light. 

To compensate for this, the photographer could
either cover the windows with expensive gels 
(filters) to bring the color temperature down, or use
daylight-balanced light to illuminate the interior,
which in turn would conflict in color temperature
with the room’s lighting fixtures.

Working with a Canon digital camera, Mark
Beckelman developed an elegant solution that
requires him to photograph the scene only once as
a RAW file, acquire the file three times in Adobe
Camera RAW with different color temperature set-
tings, and then combine the separate files as
described here:

ch7_kitcheninterior.jpg 

ch7_kitchenexterior.jpg 

ch7_kitchenstove.jpg 
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figure 7.49
The final image.
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figure 7.50
After photographing the scene three times, John Warner combined the exposures to create this final image.
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1. Mark shoots only in the RAW file format,
which yields both higher image quality and
greater creative interpretation upon acquiring
the file. In this instance he acquired the same
image three times (figure 7.51)—once with
tungsten for the interior scene, once with day-
light color balance for the exterior light seen
through the windows, and once as a darker
version that maintained the detail in the
bright wall above the stove.

2. Using the primary interior exposure as the
Background layer, he Shift-dragged the win-
dow layer on top and named the layer window. 

3. Mark outlined the windows with the Pen tool,
turned the path into a selection, and clicked
the Layer Mask button of the window layer,
which added a layer mask. The mask reveals
only the windows (figure 7.52) and now
combines the daylight-balanced exterior with
the interior.
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figure 7.51
Acquiring the same exposure three times using different
Camera RAW settings is the foundation of the composite.

figure 7.52
Combining the interior with the exterior exposures.

4. Mark noticed some daylight spill (figure
7.53) that was contaminating the scene. He
removed it by painting on the window layer
mask with a low-opacity, soft white brush to
reveal the color-corrected layer.

5. After Shift-dragging the stove highlight 
file onto the composite, he (Option-clicked) 
[Alt-clicked] on the Layer Mask button to add
a black layer mask that concealed the entire
layer. He then subtly painted back the high-
lights with a low-opacity, soft-edged white
brush (figure 7.54). 

Interior exposure

Exterior exposure

Highlight exposure



figure 7.53
Light has a tendency to spread and spill, which can be cor-
rected with layer masking.

figure 7.54
The light brick above the stove was acquired separately and
then blended with a painted layer mask. 
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figure 7.55
Paying attention to the smallest reflections and color details
is part of being a professional photographer.

figure 7.56
After adding a Photo Filter layer, Mark sampled the offend-
ing blue color. 
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figure 7.57
Invert the A and B values to create the opposite color.

Removing Color Contamination
Being the accomplished professional that he is,
Mark noticed a few hints of blue, caused by the day-
light that hit the reflective surfaces of the lighting
fixtures and on the kitchen counters (figure 7.55).
He used the following sophisticated technique to
neutralize the color spill:

1. After zooming in on the blue, Mark added a
Photo Filter Adjustment Layer, clicked on the
square Color picker, and sampled the offend-
ing blue color (figure 7.56). For additional
information on working with the Photo Filter
Adjustment Layer feature, see Chapter 12,
“Photorealistic Compositing.” 

2. To neutralize the blue, he needed the exact
opposite color, which is only possible to cal-
culate with the LAB values. LAB is a color
mode that defines the image as Luminance
and two color channels. It is used to calculate
color relationships. If the A or B values are
positive, making them negative, or vice versa,
will flip the color values exactly to the oppo-
site (figure 7.57). To neutralize the color
completely, Mark increased the density of the
color correction to 100%.

3. He then inverted the layer mask and painted
over the offending blue with a small, soft-
edged white brush to remove the color along
the kitchen curtain and the chrome lights
(figure 7.58).
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figure 7.58
Painting away the blue reflections polishes the image.
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Creative Color Interpretations
Accentuating color temperature differences can
add a beautiful creative twist to your images. Figure
7.59 shows the same camera RAW file acquired
twice—once with daylight settings and once with
interpretive color settings. As John Warner
explains, “The first version is color balanced as if
the light source were near tungsten, so the Blue
Ridge Mountains become very blue. For the second

version, I re-adjusted the Adobe Camera RAW set-
tings to yield a smoky sepia and dialed down the
exposure to keep the sky from burning out.” 

After acquiring and saving both files, John Shift-
dragged the warmer file onto the blue file, and
added a layer mask to the top file (the warmer file).
He then used a large, soft brush to paint in the sepia
tones. After changing the blending mode of the sky
to Color, the image comes together (figure 7.60). 
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figure 7.59
Acquiring the same camera RAW file twice using different color balance settings.



figure 7.60
Combining the two color-interpreted files using a layer mask
creates a hauntingly beautiful image.

N o t e

You can use the Mergenator script to automati-
cally combine files that were acquired with 
different color temperature or exposure settings.
Developed by Thomas Ruark and Julieanne Kost
from Adobe Systems, Mergenator makes layered
documents on which you apply layer masking to
create the final image. To use the Mergenator,
first install the script into the Presets/Scripts
folder, make three folders (for example, Color 1,
Color 2, and Done), and then select File > Script
> Mergenator (figure 7.61) to create a new com-
posite image without your having to open and
drag the images manually.

ch7_Mergenator.sit
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figure 7.61
To automatically combine the images, point the Mergenator
Script at the two images containing the color-interpreted files
and the composite folder.

Extending the Time of Day
For me, watching a sunset is as good as watching a
thrilling Hollywood movie. But often when I pho-
tograph the scene, I’m disappointed by the results.
In most cases, this is because either the sky looks
good but the landscape is too dark, or the landscape
looks good but the sky is washed out. 

In the following example, John Warner set up his
camera on a rooftop high above Asheville, North
Carolina, and made two separate exposures—one
for the cityscape, which required a longer shutter
speed to capture the shadow detail, and one for the
sunset. For a first-person commentary from John
about the differences between getting multiple
exposures using film versus digital, see the sidebar.



Obtaining Multiple Exposures Using Film
and Digital: An Imagemaker Reflects 

“When I worked with sheet film and a 4 × 5 Sinar
view camera, doing double exposures on the same
piece of film was tedious at best. It required exposing
for the mountains and the sky at sunset, which left the
city buildings looking like dark cardboard cutouts.
After the sun went down, I had to keep the camera
absolutely still for another hour until the sky was black
and the city lights were gleaming. Then with a 40
magenta filter over the lens, I would re-photograph
the scene for 8 minutes to ‘burn’ the city lights into the
dark building shapes. Because the sky was black, no
additional exposure would wash out the sunset, sky,
and mountains. Of course, with this technique I had
only one chance per sunset to get it right. 

“Digital is far more forgiving. The approach is essen-
tially the same as with film—it requires getting a good
sunset shot that correctly exposes the sky and the
mountains but leaves the foreground buildings as
dark objects. About 45 minutes after sunset, I capture
some additional shots exposing for the city lights 
(figure 7.62). Using Adobe Camera RAW, I can cor-
rect the color balance of the artificial lights away
from their greenish cast, which eliminates the need

for the 40 magenta filter. Shift-dragging the night
exposure over to the sunset using the Lighten blend-
ing mode completes the composite. Another key
advantage of digital is having multiple sunset frames
to choose from, unlike the film example where you
get one per session.”

—John Warner

To combine the multiple exposures of the sunset
scene, John did the following:

1. After Shift-dragging the city file onto the
sunset file, John added a layer mask and used
a large, soft-edged, black brush at 35% opacity
to paint over the sky, which concealed the
washed-out sky and revealed the properly
exposed sky.

2. To boost the saturation of the sunset, he
added a Hue/Saturation layer and increased
the saturation by 30% to create the final
image (figure 7.63).
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figure 7.62
The proper sky exposure is on the top, while the proper city
lights exposure is on the bottom.

figure 7.63
After blending the two exposures together, John used a
Hue/Saturation layer to saturate the sky.
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Modeling Architecture Using Light
One of the best aspects of working on a book like
this is the opportunity to learn from many different
imagemakers. Take a look at the home in figure
7.64. Now take a look at the seven separate photo-
graphs John took to capture the best light for the
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figure 7.64
The final composite was created from seven separate exposures. 

various aspects of the home, from the façade he lit
with portable flash units; to the rooms where he
used a warmer, more inviting light; to the exposures
for the driveway, the sky, and the mountains in the
background (figure 7.65).

figure 7.65
The seven component images were shot over a three-hour time period.



figure 7.66
Using the initial exposure as a guide, the sky is added.

figure 7.68
The roof was photographed earlier in the day.
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figure 7.67
The Lighten blending mode adds natural-looking window
lights.

John arrived a few hours before sunset to find the
best angle to photograph the house and to plan the
lighting. As he told me, “I always begin with the
exposures of the exterior first, as they are the over-
all brightest elements in the image.” 

1. After downloading the files, John identified
the best exposures for each element of the
building. Starting with the initial exposure,
he added the sky file and painted away the
driveway with the layer mask and a soft-edged
brush (figure 7.66).

2. He then added the lighter layers for the
façade and room lights, all of which he set to
the Lighten blending mode and adjusted the
opacity to lighten the areas without overex-
posing them (figure 7.67).

3. John added the roof exposure and a layer
mask and then painted away everything
except the roof (figure 7.68).

4. He used two layers to enhance the driveway.
Finishing touches included removing the dis-
tracting stripe of lights along the walkway 
and color correcting the stones on the right
side of the frame to create the image shown
in figure 7.69. 
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figure 7.69
The final composite.

figure 7.70
Photographed over a period of a few months, the two images
each carry important information.

Extending the Seasons
Photographing a large subject over time requires
patience—but the results are certainly worth it as
the photograph of the Biltmore Estate in Asheville,
North Carolina, reveals. Taken over a period of a
few months, the final composite combines a night
shot with a late spring photograph in which the
trees frame the estate (figure 7.70) to create the
final composite shown in figure 7.71. 



T i p

To photograph the same subject over the course
of days, weeks, or months, it is necessary to tri-
angulate the tripod. After you set up the first shot,
measure and write down the height from the tri-
pod head to the ground. Then measure and note
two vertical distances to fixed objects and the tri-
pod head. If you use a zoom lens, also note the
exact zoom setting you used. In the example of
the Biltmore Estate, John was standing between
two columns which he used as anchor points to
triangulate the exact position of the tripod head
so that he could return months later and set up in
the same spot.

CLOSING THOUGHTS
Remember, if you want to conceal an area, paint the
layer mask with black; if you want to reveal more of
a certain area, the layer mask must be white. That’s
all there is to it—so grab a few files, stack them on
top of one another, add some layer masks, and then
start painting to hide, reveal, and conceal the image
areas. I promise that if you do this a few times, you’ll
become a happy Photoshopper who can finally say,
“I get it!” More importantly, you’ll enjoy working
with Photoshop more.
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figure 7.71
The final composite is a stunning example of combined images.
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